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Overview

Part 1: DICOM data loading in 3DSlicer

Part 2: 3D Interactive exploration of thoraco-
i abdominal CT data using Volume Rendering

= Part 3: 3D Interactive exploration of MR head data
s using Surface Rendering

Part 4: 3D interactive exploration of the segments of

=8 » the liver using Surface Rendering

Part 5: 3D interactive exploration of the segments of
the lung
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3D Visualization of the Anatomy

®

Following this tutorial,
you will be able to load
and visualize volumes
within Slicer4.2, and to
interact in 3D with
structural images and
models of the anatomy.
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®

3DSlicer

Powerful processing. Streamlined interface. 1 Extensible platform.

Slicer is a freely available open-
source platform for segmentation,
registration and 3D visualization of
medical imaging data.

3DSlicer is a multi-institutional effort
supported by the National Institute of
Health.
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3DSlicer

®

* An end-user application for
image analysis

* An open-source environment
for software development

» A software platform that is both
easy to use for clinical
researchers and easy to extend
for programmers
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www.slicer.org

®

®eno - - - - 3D Slicer

[« [ > ] [+ [Entp:/ jwwwsicer.org/ ¢ Ji(Q- Google )
L Slicer
b li A multi-platform, free and open source software package for
. \ 3DS icer visualization and medical image computing
. 4
] ] . Download | Tutorlals  Reference | Feedback
IS a mMult-platiorm
uuuuuuuuuu
L Powerful processing. eal Extensible platform.
AAAAA Slicer | okl
sortware running on - =
nnnnnnnnnnnnnnnn
aaaaaaaaa

Windows, Linux,
and Mac OSX.

Disclaimer

It is the responsibility of the user of 3DSlicer to comply with both the terms of the license
and with the applicable laws, regulations and rules. Slicer is a tool for research, and is
not FDA approved.
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‘ﬁb 3DSlicer History

Image Courtesy of the CSAIL, MIT

1997: Slicer started as a
research project between the
Surgical Planning Lab (Harvard)

and the CSAIL (MIT)
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®

3DSlicer History

Extensible platform.

Y.
\ VO »
¢ " -~ .

1997 Slicer started as a
research project between the
Surgical Planning Lab (Harvard)
and the CSAIL (MIT)

2012: Multi-institution effort to
share the latest advances in
Image analysis with clinicians
and scientists
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NA-MIC and NA

NA-MIC Wiki

General
»Overview
»Organization
»Contact Us

Center Components
»Algorihms

»Engineering

»Drving Biological Projects
»Colaboration Grants

Resources
»Publication DB
»image Gallery
»Downloads
»Service
»Training
»Dissemination
»Events.
»Links

National Alliance for Medical Image Computing
A National Center for Biomedical Computing
Funded under the NIH Roadmap Initiative

(GOt Custom Search] ST

RSNA "3”01’1‘V

T

97th Scientific
Assembly and
Annual Meeting

November 27 - December
2, McCormick Place,

0 Read more.

0 NEWS ARCHIVE

1 0f 23 Photos

The Natlonal Alllance for Medlcal Image Computing (NA-MIC) is a

y team of p scientists, software
engineers, and medical ir who develop { tools for
the analysis and visualization of medical image data. The purpose of the
Center is to provide the infrastructure and environment for the
development of computational algorithms and open-source technologies,
and then oversee the training and dissemination of these tools to the
medical research community.

Supported by the National Institutes of Health, Roadmap Initiative.

Information about collaborating with NA-MIC is available on our wiki.

Neuroimage Analysis Center

"understanding the human brain through imaging”

About the NAC
»Overview
»Organization
»Research Cores
»Collaborations

Resources
»Contact Us
»Publication DB
»Image Gallery
»Downloads
»Training Materials
»Web Archive

)¢ W’&@ )

Control Group DDC Group

State-space Models of Mental Processes from fMRI
Spatial Maps. The sverage cors mape of e o groups (vaxskwise group sverage divded by group sid.

dav.) are displayed on an Inflsied braiv-surface (af ltaral-posteror, o mediakpostrir, ight terior and right
lateral-posterior). Each row shows the maps for one phase of the task and values t < 3 have been masked out for clarity.

»»More...

»>Featured Image Archive

The Neuroimage Analysis Center (NAC) develops image processing and analysis techniques for
basic and chnlcal neurosciences. The NAC research approach emphasizes both specific core

ion projects. The activities of the NAC are centered at the
Harvard Medlcal School and the Surgical Planning Laboratory at the Brigham and Women's
Hospital in Boston, with collaborators throughout the United States and the rest of the world.

The NAC is a major research center supported by the National Center for Research Resources

(NCRR), a component of the National Institutes of Health.
D YEH
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Slicer: Behind the scenes

§ Safari File Edit View History Bookmarks Window Help GO M S <) @ 11:07AM Q
CDash - Sicer4
+ |€ http:/ /www.cdash.org/slicer4 /index.php?project=Slicer4 ¢ Q- Google

Login All Dashboards Doo N o208 00

Slicer4

S . . u .
Dashboard Calendar Previous Current Project I I C e r I S b I I t e V e
'WARNING: This CDash instance is running the bleeding edge svn trunk CDash code, and is updated frequently. You | ry

1 file changed by 1 author as of Sunday, November 27 2011 - 22:00 EST

nlght on WindOWS,

Windows7-VS2010-32bits-QT4.7.1-PythonQt-With-Tcl-CLI-

factory-win7 Kitware Roloase @ 107 .
factory-mac-64bits.kitware SnowLeo?erqg++4.2. 1-64bits-QT4.7-PythonQt-With-Tcl-CLI-
Release W&
factory-ubuntu-64bits.kitware LS:*Q»M.4.3«54bns—QTA47-Py!nonQt—wilh-Tcl—CLl-Relaase
factory-win7.Kitware VWHWWSZ-VS\ZOOG-S“DWS—QTL[‘I -PythonQt-With-Tcl-CLI-
Release &/
factory-win7.kitware Wmdows?-VSZOOB-GZMB—QT‘QJJ -PythonQt-With-Tcl-CLI-
Release %

site Build Name Build Time
whitecube kitware & SnowLeopard-gocd.2.1-Qt4.7.0-PythonQt-With-Tel-Release 11 hows ago
@
. OpenSuse-c++4.5.0-64bits-QT4.6.3-PythonQt-With-Te-NoCLI- T
Release
eris itware Linux-g++4.4-QT4.6.3-PythonQt-CLI-Release 3 hours ago
e Iinx(«y-m.4,3-QT4.7-Pymoan-W’nh-Tcl-CLI-Valgvind—Relsase .,
factory-ubuntu-64bits Kware Linux-g++4.4.3-64bits-QT4.7-PythonQt-With-Tcl-NoGLI- 11 hours ago

Coverage-Release
sagarmatha.kitware Linux-g++4.3.3-QT4.7-PythonQt-With-Tcl-NoCLI-Release 12 hours ago

Build Time

OpenSuse-c++4.5.0-64bits-QT4.6.3-PythonQt:

1 hour ago
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N Slicer Training

* Hands-on training
workshops at national
and international
venues

« >2.000 clinicians,
clinical researchers
and scientists trained
since 2005
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3DSlicer version 4.2

Powerful processing. | Streamlined interface. [ Extensible platform.

& 3D Slicer ...
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To start Slicer, select Start > All
Programs—> Slicer4-2

Welcome to Slicer

00

3D Slicer 4.2.0-rc1-2012-10-2.
File Edit View Help
& |Modules: . |2 Welcome to Slicer <) - PO &« ~
1 &
B sosiicer
e

Gy Load DICOM Data e, Load Data
i# Customize Slicer @ Download Sample Data
» About

» The Main Window

» Loading and Saving

» Display

» Mouse & Keyboard

» Documentation & Tutorials

» Acknowledgment
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ACPC Histogram Matching 4 Transforms
View Help Add Scalar Volumes Image Label Combine Vector Demon Registration (BRAINS)
é Modules: . | Welcome to Slicer Affine Registration Intensity Difference Change Detection (FAST) Vector to Scalar Volume
All Modules @2 :t:no(ations Label Map Smoothing I View Controllers
1 ) tlasTests Label Statistics ViewControllers Sli i
Q 3DSlicer f 3:::8"""5 BSpIine Dsfomablg ngismnlion Ia.beIToggIe.Bugz_Ms ® Volume Rend;:nsgllcs Interpolation Bug 1926
BSpline to deformation field Linear Registration
& DICOM @ Cameras Mask Scalar Volume @ Volumes
N N N Voting Binary Hole Filling Image Filter
We I Co n ~ Editor Cast Scalar Volume Median Image Filter WebGL Export
© Models ChangeTracker Merge Models 2\ Welcome to Slicer
- # Scene Views Charting Model Maker
| s Load DICOM Data | « CheckerBoard Filter Model To Label Map
[ = Slicer | view C ® Colors © Models
© Volume Rendering Create a DICOM Series Multiply Scalar Volumes
» About @ Volumes @ Crop Volume MultiVolumeExplorer
—— It Curvature Anisotropic Diffusion MultiVolumelmporter
jalhio MainWindow, o o Steer 4 Data NA4ITK MRI Bias correction
3 loadngand Saving |  Mzards DataProbe 3¢ OpenlGTLInkIF
o Demon Registration (BRAINS) Orient Scalar Volume
» Display | :99'5“'3"";‘ 5 DICOM Otsu Threshold Image Filter
ok oaton DICOM to NRRD Converter Otsu Threshold Segmentation
Diffusion Diffusion Tensor Scalar Measurements Performance Tests )
aT Diffusion Weighted Volume Masking PET Standard Uptake Value Computation
—— DTlexport Probe Volume With Model
» Acknowledgment s rlaeg Model DTlimport % Reformat
1 C:nverlers el DWI Joint Rician LMMSE Filter Resample DTI Volume
Endoscopy DWI Rician LMMSE Filter Resample Image (BRAINS)
Utilities DWI to DTI Estimation Resample Scalar Volume
Developer Tools DWI to Full Brain Tractography Rfegample_ Sca!arNemorlDWl Volume
Legacy DWI Unbiased Non Local Means Filter Rigid Registration
Testing ~ Editor Robust Multiresolution Affine Registration
EMSegment Command-line Robust Statistics Segmenter
Work in Progress M with Atlas RSNA2012Quant
& EMSegmenter without Atlas RSNA2012Vis
(Issue 2428)
n Growing Segmentation
ic
-ashBug2590
lar Volumes
-alar Volume
Display
Interactive Seeding
Label Map Seeding
ML Files to New EMSegmenter Standard
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ACPC Transform General Registration (BRAINS)
Add Images Gradient Anisotropic Diffusion Statistics Segmentation
2 Annotations Grayscale Fill Hole putation

BSpline to deformation field Grayscale Grinid Peak B
Gameras Grayscale Model Maker ~ Scene Views

Cast Image Histogram Matching Simple 10 Test
ChangeTracker Image Label Combine Simple region growing
CheckerBoard Filter Intensity Difference Change Detection (FAST)
Colors Joint Rician LMMSE Image Filter

Create a DICOM Series Label Map Smoothing
Crop Volume Label Statistics oT

Curvature Anisotropic Diffusion Lingar registration
DICOM MR Bias Field Correction

DWI to Full Brain Tractography :""5“ :"‘39: T Tractography Labelmap See
a ISR TONT DNTOSTON YYOTgTog Arges Transform MRML Files to N

EMSegmenter Standard i

Transforms
Unbiased Non
§ View Controllers
ements o " @ Volume Rendering
‘ommand-iine " @ Volumes g
i EMSegmenter with Atlas ‘ Voting Binary Hole Filling b7
& EMSegmenter without Atlas Welcome 1o Slicer
Editor
Endoscopy
Event Broker
Execution Modei Tour o S i
Expert Automated Registration S ! £
Extract Skeleton
Fast Affine registration o e Vot Mol (Pain) e
Fast Nonrigid BSpline registration ’ W
on o !
fon

ng (BRAINS)

Al Means filter for DWI

Resampl
Resample Scalar Volume

Resampie Scalar/VeclorfOWi Voiume
Rician LMMSE Image Filter

Slicer4.2 contains
more than 90
modules for image
segmentation,
registration and 3D
visualization of
medical imaging data
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Loading a DICOM Volume

Slide 16
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‘ﬁ' The DICOM 3.0 File Format

Most radiological imaging equipment produce images
in DICOM file format (‘.dcm files’)
|

— — Image001.dcm

Header

Image002.dcm

Raw Data

Image003.dcm

©2012-2013 Surgical Planning Laboratory, ARR Slide 17



Loading a DICOM volume

FEile Edit View Help

ga Modules: . & Welcome to Slicer =0 Q9O a@ ¢« t - o fe | 4~
e= [l
8- * \ \
Welcome ”
<@,Loadmcomoata ? wio Load Data CIiCk On Load DICOM
i i Download Sample Data
» About

Data in the panel of the

» Loading and Saving

Welcome to Slicer

» Mouse & Keyboard
» Documentation & Tutorials m Od u I e
» Acknowledgment

BEREX $:0.00] -

Y & R:0.00[8 G & A:0.00

~ Data Probe

L
E
B

None RAS: (125.0, -125.0, 1.0),
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Loading a DICOM volume

3D Slicer 4.2.0-rc1-2012-10-28

ile
%2 # % |Modules: - [:DICOM = Q0 I9® @@ « @ t-18 w f

@ 3DSlicer
4

» Help & Acknowledgement

Eile Edit View Help

800 DICOM Details

Import Export Query Send Remove LocalDat:#/Users/spujol/data/DICOM-database |

~ Servers

Start Listener J

8 Name + Age Scan Date Subject | Number Institutiol Referrer Performer
Start Listener when Slicer Starts
- DICOM Database and Networking J
Show DICOM Browser |
- Recent DICOM Activity J
0 series added to database in the past hour
DICOM Data Reader Warnings

Refresh |

[«

I v
| Uncheck All Load Selection to Slicer | Close

Make DICOM Browser Persistent

The DICOM Details
window appears

< )

~ Data Probe

L
F
B

None RAS: (125.0, -125.0, 1.0),
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Loading a DICOM volume

e 00 DICOM Details
Import Export Query Send Remove LocalDat:#/Users/spujol/workshop/RSNA2012/data/DICOM-database
Name ~ Age Scan Date Subject | Number Institutiol Referrer Performer

Click on Local Database, and select the directory
C:\Documents and Settings\Administrator
\Desktop\3DSlicerData\DICOM-database . Reader Warnings

Uncheck All Load Selection to SIicér Close
*' " Make DICOM Browser Persistent

©2012-2013 Surgical Planning Laboratory, ARR
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Loading a DICOM volume

DICOM Details
@xpon Query Send Remove LocalDat:#/Users/spujol/workshop/RSNA2012/data/DICOM-database|
Name ~ Age Scan Date Subject | Number Institutiol Referrer Performer

Click on Import, browse to the location of the 3DSlicerData directory

e O 0 Import DICOM files from directory ...
Look in: ta/Users/spujol/workshop/RSNA2012/data 1000 & [ \E\
A 'spu Name v Size Kind Date Modified

= 3DSlicerData

10/29/...:20 PM

1 DICOM-database

CIENED
Directory:  |3DSlicerData

-- Folder 10/29/...:45 PM 5

Files of type: Directories
Copy on import

a
=

| X Cancel|
[

Uncheck All

|Load Selection to Slicer|

< [»

Make DICOM Browser Persistent

Close

©2012-2013 Surgical Planning Laboratory, ARR
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Loading a DICOM volume

Y- y _ DICOM Details
xport Query Send Remove LocalDat¢#/Users/spujol/workshop/RSNA2012/data/DICOM-database |

Name + Age Scan Date Subject | Number Institutiol Referrer Performer
806 DICOM files from directory
Look in: \@/Users/spujol/workshop/RSNA2012/data/3DSlicerData | @ © @ @ [
4 spujol Name v Size Kind Date Modified
= CT-Thorax-Abdomen -- Folder 10/29/...:32 PM

Directory: |CT-Thorax-Abdomen
Files of type: Directories
Copy on import

Gl I )
| Uncheck All | Load Selection to Slicer | Close
‘_[;‘l "' Make DICOM Browser Persistent

©2012-2013 Surgical Planning Laboratory, ARR
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Loading a DICOM volume

DICOM Details

Import Export Query Send Remove LocalDat:#i/Users/spujol/workshop/RSNA2012/data/DICOM-database|

Name ~ Age Scan Date Subject | Number | Institutiol Referrer Performer
= patient1 patien...
= CT Thorax Abdomen 2005-... 6936864 oEfZQ...
CT_Thorax_Abdomen CT 6 2005-... HEART 14
« | )
DICOM Data Reader Warnings

| UncheckAll | Load Selection to Slicer | Close

. ' Make DICOM Browser Persistent
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Loading a DICOM volume

20 00 DICOM Details
ampon Export Query Send Remove LocalDat: #/Users/spujol/workshop/RSNA2012/data/DICOM-database

Name ~ Age Scan Date Subject | Number Institutiol Referrer Performer
- patient1 patien...
= CT Thorax Abdomen 2005-... 6936864 oEfZQ...
- CT_Thorax_Abdomen CT 6 2005-... HEART 14

Click to expand the DICOM Browser window.

Slicer displays the snapshots of the DICOM images
of the CT_Thorax_Abdomen dataset

DICOM Data Reader Warnings 5
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...

L CT Thorax Abdo... Scalar Vol... S
Image 19 ol Uncheck All Load Selection to Slicer Close

Make DICOM Browser Persistent

Image 16 Image 17 Image 18

D
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Loading a DICOM volume

®00 DICOM Details
Import Export Query Send Remove LocalDat: #/Users/spujol/workshop/RSNA2012/data/DICOM-database
Name ~ Age Scan Date Subject | Number Institutiol Referrer | Performer
- patient1 patien...
= CT Thorax Abdomen 2005-... 6936864 oEfZQ...
- CT_Thorax_Abdomen CT 6 2005-... HEART 14

Click on Load Selection to Slicer to load the
DICOM volume into Slicer

Image 4 F DICOM Data Reader Warnings
CT_Thorax_Abdo... Scalar Vol... =
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT Thorax Abdo..  Scalar Vol S

PDDDDDDADDDDDD DD

Image 17 Image 18 Image 19 all Uncheck All Load Selection to Slicer Close
Y Make er Jg¥sistent

<

©2012-2013 Surgical Planning Laboratory, ARR
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Loading a DICOM volume

806 3D Slicer 4.2.0-rc1-2012-10-28

File Edit View Help

g & & Modules: . @DICOM (" Q0 |90 «@ 2 B t-18 w M-
1

B®

\@ 3DSlicer

» Help & Acknowledgement

~ Servers

Start Listener J
Start Listener when Slicer Starts
~ DICOM Database and Networking
Show DICOM Browser
~ Recent DICOM Activity

1 series added to database in the past hour
Today: CT_Thorax_Abdomen for patient1

Refresh

~ Data Probe
| Red RAS: (-79.4,290.2,-188.5) Axial Sp: 2.0

Slicer displays the axial, coronal and
sagittal slices of the DICOM dataset
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Loading a DICOM volume

e 00 3D Slicer 4.2.0-rc1-2012-10-28
Eile Edit View Help
ga Modules: . |@ Volumes 1m0 09O el v t- R
o= [l
:@ Slicer

» Help & Acknowledgement

Active Volume 6: CT_Thorax_Abdomen
» Volume Information

~ Display

Lookup Table: |

Interpolate: v
Window Level editor prese

WOkl L

) W:350 - [Manual WiL ' L0 [ ’ .
Threshold: off g

-1434 * 3480 .
. - A:169.00
» Histogram i

Click on the Window Level
Preset CT-abdomen, or
adjust manually the Window
and Level using the Manual
WI/L slider
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Loading a DICOM volume

006

3D Slicer 4.2.0-rc1-2012-10-28

el

ile Edit View Help
&a %a 'Modules: . @ Volumes

B

@ 3pSlicer

» Help & Acknowledgement

Active Volume 6: CT_Thorax_Abdomen

» Volume Information

~ Display

Lookup Table: I Grey

Interpolate: v
Window Level editor presets:

SRS ©

£

W:350 I/ Manual W/L +||L:40

Threshold: Off

-1434 ° 3480
» Histogram

Select the module Volume
Rendering in the Modules
Menu

wmr

"0 9O &«@ <2 |EH|t-E %

©2012-2013 Surgical Planning Laboratory, ARR
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Loading a DICOM volume

F|Ie Edit View Help

ga & % Modules: - @Volumes = Q, PO el 2| HIt-B8 w4+~
ox @1 H
@ SSSSSS

» Help & Acknowledgement

Active Volume 6: CT_Thorax_Abdomen
» Volume Information

Position the mouse cursor
over the red banner in the

Red Viewer to display the

SI ice me n u = : L|k/Unnk the sl|ce

controls (except
{

Click on the Link icon to link
the slice contrils across all
Slice Viewers.

Click on the Eye icon to
display the three anatomical

slices in the 3D Viewer

_/, ARR
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°/) Loading a DICOM volume

00

(2]

File Edit View Help

ga & & |Modules: . @Volumes = Q. PO ed t - Ao R,
1

@,s \\\\\

» Help & Acknowledgement

Active Volume 6: CT_Thorax_Abdomen
» Volume Information

~ Display
Lookup Table:| ¢ Grey

Interpolate: v
Window Level editor presets:

Wil @ a

W:350 7/|Manual W/L +||L: 40
Threshold: Off ¢
-1434 3480 . =T

N 6:CT...domen :

The three anatomical
slices appear in the 3D
viewer. Use the right-
mouse button in the 3D
Viewer to zoom in and out
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Loading a DICOM volume

8 00 3D Slicer 4.2.0-rc1-2012-10-28
File Edit View Help

g3 & & Modules: .| @Volumes (" Q0O PO @@ 2 HIt @ W 5 -

Q 3DSlicer

» Help & Acknowledgement
Active Volume 6: CT_Thorax_Abdomen
» Volume Information

~ Display
Lookup Table: [lF Grey

Interpolate:  ~
Window Level editor presets:

Wi B @ A

W:350 I/|Manual W/L +||L: 40
Threshold: Off <
-1434 20 113480 .

Use the left-mouse button
in the 3D Viewer to rotate
the 3D volume

wmr

©2012-2013 Surgical Planning Laboratory, ARR
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Loading a DICOM volume

500

File Edit View Help

& & |Modules: - @ Volumes =0 PO «@ v . P
o QIS

PSS  alelee
@ ssssss R L [[Center the 3D
A view on the scene
» Help & Acknowledgement P .

Active Volume 6: CT_Thorax_Abdomen
» Volume Information

~ Display
Lookup Table: I Grey

Interpolate: v
Window Level editor presets:

il O PE a

W:350 I Manual W/L < |L: 40
Threshold: Off 2
-1434 * 3480 | .

Position the mouse over the
blue banner in the 3D viewer
window to display the 3DView
controller, and click on the top
left icon to center the 3D view
on the scene

©2012-2013 Surgical Planning Laboratory, ARR
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Loading a DICOM volume

8 00 3D Slicer 4.2.0-rc1-2012-10-28
File Edit View Help
ga Za '‘Modules: . @ Volumes 3| - 8 I € Ao R, v

Conventional Widescreen

= Conventional Quantitative
& Four-Up
@ Four-Up Quantitative

@ OSlicer

» Help & Acknowledgement 3

Active Volume 6: CT_Thorax_Abdomen B
» Volume Information

3D only f
o Red slice only -
& Yellow slice only
= Green slice only

Click on the Slicer layout Florerl

= Compare »

~ Display
Lookup Table: ¢ Grey B

ek m ml ki

m Compare Widescreen »

menu icon, and selectthe o -
Conventional Widescreen
layout

® Four over four

~ Data Probe

wmr
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Loadlng a DICOM volume

Use the red ~00 00 s e Bt mnn
slice, yellow =
slice and green
slice slidersto
slice through the
volume in all
three anatomical
directions

~ Data Probe

L
E
B
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Part 2:

3D Interactive exploration
of thoraco-abdominal CT
data using Volume
Rendering
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Loading a DICOM volume

800 3D Slicer 4.2.0-rc1-2012-10-28

File Edit View Help

£ 'Modules: . ®Volume Rendering =0 Q09O @@ 2 EHIt 8 R+
ex @18

Q 3DSlicer

» Help & Acknowledgement

«Volume: [6: CT_Thorax_Abdomen
» Inputs

~ Diganlav

Select the
module Volume
Rendering in
the modules
menu

~ Data Probe

L
E
B
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Loading a DICOM volume

3D Slicer 4.2.0-rc1-2012-10-28

800
Eile Edit View Help
ga Modules: - |®Volume Rendering

\-OJ PO @2 2Bt 18 & |t~

Q 3DSlicer

» Help & Acknowledgement

«+Volume: |6: CT_Thorax_Abdomen
» Inputs

~ Display
o LN O@
Shift:
e (D O
Rendering: . .. !

> Advance< Q

Select the Preset
CT-Cardiac3 in the
Display tab =

E
B
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E
ga & & Modules: . |®Volume Rendering - Q. PO e 2 t - Ao Fo, -
{.

» Help & Acknowledgement

2 <~Volume: [6: CT_Thorax_Abdomen
» Inputs

~ Display

Preset: @ CT-Cardiac3 B
Shift: e

Crop: Enable < Display & Fit to Volume
Rendering: NCI GPU Ray Casting z
» Advanced...

Select the Rendering NCI
GPU Ray Casting, and
click on the eye icon in the
Volume tab to display the
Volume rendered volume
In the 3D viewer
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GPU Volume Rendering

3D Slicer 4.2.0-rc1-2012-10-28

File Edit View Help
# Modules: . @ Volume Rendering =00 19O «@ « |EHIt- e Fa

Q 3DSlicer

» Help & Acknowledgement

2 = Volume: |6: CT_Thorax_Abdomen ¢
» Inputs

~ Display

Preset: @ CT-Cardiac3 B
Shift:

Crop: Enable «Display ROl |+ Fit to Volume|
Rendering:NCI GPU Ray Casting C
» Advanced...

Slicer displays the 3D
rendered volume of the
CT _Thorax_Abdomen dataset

~ Data Probe

wnr
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GPU Volume Rendering

3D Slicer 4.2.0-rc1-2012-10-28

806
File Edit View Help
ga # 2 Modules: - ®Volume Rendering Q09O e v t- An o,

E 3DSlicer

» Help & Acknowledgement

#\Volume: 6: CT_Thorax_Abdomen ¢
» Inputs

~ Display
Preset: @ CT-Cardiac3 2

Shift: — :
/ Crop: v Enable = Display ROl | Fit to Volume |
Rendering:|NCI GPU Ray Casting E

» Advanced...

Use the Shift slider
to shift the transfer

function andxs
display the aorta
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GPU Volume Rendering

6 00 3D Slicer 4.2.0-rc1-2012-10-28

File Edit View Help

g |Modules: . |® Volume Rendering =00 PO &«@ 2 |EHIt-B w Al
o= @

@ 30Slicer "”l

» Help & Acknowledgement

«#Volume: 6: CT_Thorax_Abdomen
» Inputs

~ Display
Preset:  @CT-Cardiac3

Shift: -
/ Crop: Enable « Display ROl | Fit to Volume
Rendering: NCI GPU Ray Casting

» Advanced...

~ Data Probe
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GPU Volume Rendering

800
FEile Edit View Help

ga # & |Modules: . ®Volume Rendering =009 «@ <« |H|t- A Fa | v
ox @18

Q 308licer

» Help & Acknowledgement

#Volume: |6: CT_Thorax_Abdomen 3 4 " A\ \ X Tt

2 : A Bl 2 SRS &

» Inputs & oy i »

~ Display

Preset: wCT-Cardiac3

Shift: L

Crop: Enabl < Display ROl [&Fitto Volume | '

Renderi y Casting 2

» Advanced...

Use the right-mouse button to zoom In.
Click on Display ROI to display a region of
: interest that we will use for cropping the
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GPU Volume Rendering

Eile Edit View Help

ga # & |Modules: . ®Volume Rendering = QO 9O e 2 Bt~ Ao Ra |4
) 1@
» Help & Acknowledgement . ’ / " p N ‘;l-. \ " Ay
= Volume: [6: CT_Thorax_Abdomen 5 : " " l
» Inputs T /
~ Display e

Position the ROl around the
left and right kidneys using
the ROI controls both in the
3D viewer and in the 2D
VIeWS

\, {
‘‘‘‘‘

~ Data Probe

L
E
B
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GPU Volume Rendering

800
File Edit View Help
ga # & |Modules: . ®Volume Rendering = QO 9O e 2 Bt~ Ao Ra,

3D Slicer 4.2.0-rc1-2012-10-28

ox @18

T "‘Z"‘ { H‘. Py
B e @ > ‘\" "\\w‘\

’:

» Help & Acknowledgement

#Volume: 6: CT_Thorax_Abdomen

» Inputs

~ Display

Preset:  @CT-Cardiac3 2]
Shift:
Crop: Enable = Display ROl | Fit to Volume |
Rendering:NCI GPU Ray Casting B D)
» Advanced... [\

Click on Enable to display
the cropped volume
rendered image

~ Data Probe

L
E
B
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GPU Volume Rendering

FEile Edit View Help

ga & 2 Modules: . ®Volume Rendering =0 Q0 9O e« 2 Bt~ e Fa |4~
es @1 E

Q ........

» Help & Acknowledgement

= Volume: |6: CT_Thorax_Abdomen

» Inputs

~ Display

Preset: @ CT-Cardiac3

Shift:

Crop: v Enable = Display ROl |#Fit to Volume
Rendering: NCI GPU Ray Casting Z
» Advanced...

Slicer displays the
cropped volume rendered
images showing the left
and right kidney

F
B
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GPU Volume Rendering

3D Slicer 4.2.0-rc1-2012-10-28

®

(o)

[s)
ile Edit View Help
&a & & Modules: . ®Volume Rendering (=0 QPO & s tv @ G|+
CE] 8

!b= 3DSlicer
v

» Help & Acknowledgement

m @

B!

=\Volume: 6: CT_Thorax_Abdomen ¢
» Inputs

~ Display

Preset:  |@CT-Cardiac3 ¢
Shift:
Crop: v Enable « Display ROl | Fit to Volume |

Rendering: NCI GPU Ray Casting g »
» Advanced...

Click on File=>EXxit to quit
Slicer

~ Data Probe

wnr
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Part 2:

3D visualization of surface
models of the brain
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A Slicer scene is a MRML file which
contains a list of elements loaded
into Slicer (volumes, models,
fiducials...)

The tutorial scene contains an MR
scan of the brain and 3D surface
models of anatomical structures.

©2012-2013 Surgical Planning Laboratory, ARR Slide 48



‘ﬁb 3D models of the brain

» The tutorial data are part of the SPL-PNL
Brain Atlas developed by Thalos et al

« RSNA 2011 Presentation:

Publicly available RaxLex-linked Anatomy

Atlases for Image Analysis Informatics and
Education. Michael Halle, Samira Farough,
Marianna Jakab, Ron Kikinis

Thurs. Dec.1st, 11:10-11:20 am
Room S402AB
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Loading a Scene

8 00
File Edit View Help
& # & /Modules: . aWelcome to Slicer (=0 Q9O @ 2|
e®
@ 3DSlicer
Welcome
=& Load DICOM Data || e Load Data ]

[ #Customize Slicer || @ Download Sample Data|

» About
» The Main Window

» Loading and Saving

» Display

» Mouse & Keyboard

» Documentation & Tutorials

l
|
|
l
l
l
|

» Acknowledgment

|~ Data Probe

L
E
B

None RAS: (125.0, -125.0, 1.0),
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Loading a Scene

File Edit View Help
ga 2 & Modules: . =Welcome to Slicer il PO e« 2

.{5 Slicer
Welcome
=& Load DICOM Data mao Load Data
# Customize Slicer © Download Sample Data
» About
» The Main Window A'spu Name
< Master S View.
» Loading and Saving - opatis féhigg,?fwlew pg
- = optic_nerve_L.vtk
» Display m optic_nerve_R.vtk
= optic_tract_L.vtk
» Mouse & Keyboard = optic_tract_R.vtk
: : m right_eyeball.vtk
» Documentation & Tutorials m Skin vtk
» Acknowledgment = skull_bone.vtk

_ File name:  slicer4minute.mrml

£ R Files of type: All Files (*)

Browse to the directory MR-Head, located on the Desktop:
C:\Documents and Settings\Administrator\Desktop

\3DSlicerData

Select the file slicerdminute.mrml, and click on Open

= e '
Cho Look in: /Users/...MR-Head : @ O # (3 /E jons

- | % Cancell incel

ER X

Y &



Loading a Scene

File Edit View Help

ga 'Modules: . aWelcome to Slicer s = Q PO &4 ~ t - Ao Ra, -
; Slicer

Welcome

Load DICOM Data ma Load Data
# Customize Slicer © Download Sample Data
— 6 o Add data into the scene
» About - - .
—||/Choose Directory to Add|Choose File(s) to Add Show Options

» The Main Window |~ File ~ | Description
» Loading and Saving ~ | v ...ata/3DSlicerData/MR-Head/slicer4minute.mrml [MRML Scene
» Display

» Mouse & Keyboard
» Documentation & Tutorials

» Acknowledgment

mhuhu

X Cancel

|
Click on OK to load the 3D scene in Slicer

wmr
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Loadlng the Slicer Scene

eno cer 4.0,
@ & |Modules: . [Welcome to Slice I-JO{DO%AUZ

A 3D surface model of the
head, and 2D anatomical
slices appear in the Viewer.

| » Display

| » Mouse & Keyboard

| » Documentation & Tutorials
| » Acknowledgment

l\]t > @ e G| 4~

| ~ Data Probe

mnr

©2012-2013 Surgical Planning Laboratory, ARR Slide 53



Loading the Slicer Scene

8
@ & |Modules: . [Welcome to Slicer

@ 3DSlicer

Welcome

SDsSlicendOoamua 2RI
=00 @& s @@ ~EHe t-

ex [l

5 B A R | v

| &= Load DICOM Data || (s Load Data J
| mi@ Load Data || @ D ple Data |

[» About

[ » The Main Window

[» Loading and Saving

| » Display

| » Mouse & Keyboard

[ » Documentation & Tutorials

[ » Acknowledgment

[~ Data Probe

L
F
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Models module

800 3D Slicer 4.0.gamma-2011-11-24
@ & [Modues: (@ Models s - Q DINO &« »29@ ~EH|e E| § v iPesisent | @ Am S| 4 v
e®

@ 3DSlicer

» Help & Acknowledgement

=-Scene
# hemispheric_white_matter.vtk 1.
# left_eyeball vik m
# optic_chiasm.vik 1.
# optic_nerve_L.vtk 1.
# optic_nerve_R.vtk 1.
# optic_tract_ L.tk 1

The list of 3D
—+&———=-- models appear in

» Information

= | the Models panel

-88888888

Selected:

Clip:

Slice Intersections Visible:
v Material Properties

Color: ( O

Opacity: 0[100]7]
Ambient: @ (0004
Difuse: 0[100]Z]
Specular: (7 [EE
Power: @ (o

Backface Culling: ¥,

Preview: ﬁ Presets:;y :m
L

» Scalars

» Clipping J

v Data Probe J

Yellow RAS: (0.0, 166.7, -67.1) Sagittal Sp: 1.0

| Neana
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®

3D Visualization

B b s fores = QO DO @A GE -H0] L e @ | e

ox i
@ 3DSlicer

» Help & Acknowledgement

=-Scene
# hemispheric_white_matter.vtk
= left_eyeball.vtk
# optic_chiasm.vtk
# optic_nerve_L.vtk
rve ALVt
L.vt

v Data Probe

Yellow RAS: (0.0, 166.7,-57.1) Sagittal Sp: 1.0

| Neana
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3D Visualization

|2 & |Modules: . [@Models = Q. O I0 @ & @ ”El@ t- > B R R | 4~

g 3DSlicer

» Help & Acknowledgement

= Scene

= hemispheric_white_matter.vtk
= left_eyeball.vtk

= optic_chiasm.vtk

= optic_nerve_L.vtk

= optic_nerve_R.
= optic_tract_L.vtk
= optic_tra vtk

= right_eyeball.vtk
= skull_bone.vii K

85385358

» Information

~ Display

Visible: v

Selected:

Clip:

Slice Intersections Visible:
v Material Properties
Color: ( [m] ]
Opacity: :.
Ambient: C 10.00 |2
Diffuse: j.
Specular: 0 (0.00 4]
Power: s (1.0 4

Backface Culling: v
~ Data Probe

wmr
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3D Visualization

& Slicer File Edit View Help GO ™M=« @O Q

@ & |Moddes: (@ Models dm Q0RO @ A @ N E] 4+ persisten:

@ 3DSlicer

[ » Help & Acknowledgement )

= Scene

[ Information )

[ ~ Display ]
Visible: v
Selected:

Clip:
Slice Intersections Visible:
v Material Properties

Color: ( [m] )

Opacity: —_— (047
Ambient: 0
Diffuse:

Specular: &
Power: @

Backface Culling: [/
e Gl e
._

, Scalars

[ Ciipping ]

[+ Data Probe )

Yellow RAS: (0.0, 166.7, -57.1) Sagittal Sp: 1.0

L None ()
F None ()
B None ()
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3D Visualization

eoo 30 Sicer 40.gamma-2011-11-24
& & |Modules: . [@Models =00 N0 @& A @ » | B @ t~ » @ R R | 4~
1

@®
@ 3DSlicer

» Help & Acknowledgement I

= Scene
= hemispheric_white_matter.vtk
» left_eyeball.vtk ||
= optic_chiasm.vtk
= optic_nerve_L.vtk
= optic_nerve_R.vtk
= optic_tract_L.vtk
= optic_tract_R.vtk
= right_eyeball.vtk | |
= Skin.vtk
< skull_bone.vtk [ ]

=555885558

Information

~ Display
Visible: v
Selected:
Clip:
Slice Intersections Visible:
v Material Properties

Color: (

~ Data Probe
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3D Visualization

® Slicer File Edit View Help
B g |Moes (O 3™ QOINO @ s @ »| B @ t v pessen | [ Ba Ro | 4 v
1

EE)
@ 3DSlicer

[ » Help & Acknowledgement

®

= Scene
# hemispheric_white_matter.vtk
# left_eyeballvik
# optic_chiasm.vik
» optic_nerve_L vtk
# optic_nerve Rvik

# optic_tract_Avik
# right_eyeballvtk
# Sxinvik

9

3
< ates

£
Oaadaada
8883838383

[» Information

[~ Display

Visible:

Selected:

Clip:

Slice Intersections Visible:
'y Material Properties

Color: ( [m]

Opacity: —_—
Ambient: @

)

Diffuse: a[100[Z)
38

(an Tal

Specular @

The 3D sur%ace of the‘
white matter appears in
the 3D viewer
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3D Visualization

®

_ @& Slicer File Edit View Help % D m « @ 0O Q
eno 3D Slicer 4.0.gamma-2011-11-24
@ & |Modues @ Models = QO IO @ A @@ | 4 v Persistent fe So
= B

B®
{D 3DSlicer
4

[ » Help & Acknowledgement

= Scene

# hemispheric_white_matter.vtk 1.00
# left_eyeball.vtk . 100
# optic_chiasm.vtk 1.00
# optic_nerve_Lvtk 1.00
# optic_nerve_R.vtk 1.00
# optic_tract_Lvtk 1.00
# optic_tract_R.vtk 1.00
# right_eyeball.vtk W 100
# Skinvik 0.00
g 1 1.00 |
[ > Information
[+ Display
Visible:
Selected
Clip:
Slice Intersections Visible:
v Material Properties
Color:
Opacity: _— 1]
Ambient ———————[000[%
Diffuse: _— 1]
Specular: 2 210.00 (=4

Click on the eye icon in
the green viewer to
display the coronal slice
in the 3D viewer
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3D Visualization

COIN® & 49 H
1

®

8no 3D Slicer 4.0.gamma-2011-11-24
% & [Modules: © Models s = » o 4~ » fa Fa,

@ 3DSlicer

» Help & Acknowledgement

eric_\

= left_eyeball.vtk
» optic_chiasm.vtk
» optic_nerve_L.vtk
= optic_nerve_R.vtk
= optic_tract_L.vtk
= optic_tract_R.vtk
= right_eyeball.vtk
= Skin.vtk

— § model
hemispheric_white matter.vik,
and select the option Clip in the

~ Display |
Visible: v

Selected:
Clip: v
Slice Intersections Visible:

v Material Properties

Color: A

Opacity: —_—1.00 ] A\ DISpIay tab
Ambient: /000 %

Diffuse: —ee[1.00 |2

Specular: —/0.00 =

Power: — 10 *

Backface Culling: v 3

~ Data Probe

mTnr
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3D Visualization

800 3D Slicer 4.0.gamma-2011-11-24

_,0_‘JQO%AWE>»0tv > @ Ae Fa -

®

% & [Modules: @ Models

[ENRE

@ 3DSlicer

» Information

~ Display
Visible: v
Selected:
Clip: v
Slice Intersections Visible:

v Material Properties

Color:

Opacity: —_—1.00
Ambient: F 0.00
Diffuse: —1|1.00
Specular: ——/0.00

elect the tab Clipping, and set
the Green Slice Clipping to
Negative Space

) 3 ) G [

Power: F 1.0
Backface Culling: v
Preview: g Presets: B

» Scalars
~ Clipping
Clipping Type: @ Union (@
Red Slice Clipping: *— Positive O &
Yellow Slice Clipping: © *  Positive © *
v Green Slice Clipping: © #— Positive @ £— Negative

~ Data Probe

wmr

©2012-2013 Surgical Planning Laboratory, ARR Slide 63



3D Visualization

®

[ JeXe) 3D Slicer 4.0.gamma-2011-11-24

%2 & Modules: © Models - Q_Q DO &« A§@ » IR
1

@ o
®

@ 3DSlicer

The optic chiasm appears
in the 3P_lviewer

oy

Color:

Opacity: ———1[1.00 |J
Ambient: —=—ox0.00 |
Diffuse: —_— (1002
Specular: ——=0.00 *
Power: (10 [

Backface Culling: v

Preview: g Presets::_y m

» Scalars
~ Clipping |
Clipping Type: @ Union @ () Intersection

Red Slice Clipping: *— Positive O +— Negative
Yellow Slice Clipping: © £ Positive © £ Negative

v Green Slice Clipping: © #— Positive @ £— Negative

~ Data Probe

T
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®

3D Visualization

e no 3D Slicer 4.0.gamma-2011-11-24

%2 & [Modules: - |@ Models = Q. 9 DO e« A g » B lle ¢t~ > @ Ao R -

Q 3DSlicer

» Information

~ Display
Visible: v
Selected:
Clip: v
Slice Intersections Visible:

v Material Properties

D14 n&

Calar-

Select File 2 Exit tov close the Brain Scene, a Slicer

)

Power: (10 %
Backface Culling: v
Preview: &

» Scalars

~ Clipping
Clipping Type: 9 Union @ (@, Intersection

Red Slice Clipping: *— Positive O +— Negative
Yellow Slice Clipping: © £ Positive © £ Negative

v Green Slice Clipping: © #— Positive @ £— Negative

~ Data Probe

T
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Part 4:

Interactive 3D Visualization
of the segments of the liver
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Anatomy of the liver

Right Right Left Left
posterior anterior medial lateral
section section section section

Right hepatic vein

Umbilical vein
(remnant)

Hepatic duct
Inferior vena cava

Cystic

Hepatic artery
duct

Portal vein

Gall bladder Bile duct
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‘ﬁb Liver dataset

The liver dataset is

a contrast-enhanced CT
abdominal scan of a
healthy 36 year-old male.
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3D segments of the liver

®

~ __ SegmentlVa

''''''

Segment VI Segment Il

Segment VI - Segmentlil

Segment V ~ Segment [Vb .

©2012-2013 Surgical Planning Laboratory, ARR Slide 69




ﬁ' 3D segments of the liver

|
Segment | | Segment |

Segment Il
Segment Vb Ve | *=" Segment VI

| ==

3 S_ngment V
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Liver vasculature

Middle Left portal .
AEENE HEll vein = |eft hepatic

q T vein
Rig ht pOrtaI | : ' ) S - ~‘:- \.- .I‘.I_-‘_::‘-""'/:'.'; :,—i:’,{( \::ﬂf; - | "i
i SRR SR & Caudate vein | =

Vel gk iy o h “— ‘

——
—

o

e

Main portal

Right hepatic gt
vein
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Loading the Liver Data Scene

800
File Edit View Help
ga & % Modules: . [Welcome to Slicer (=009 e« ~ t v @ M R

g 30Slicer

Welcome

=& Load DICOM Data || e Load Data ]
[ #Customize Slicer || @ Download Sample Data|

3D Slicer,4,2.021¢152012510,28

» About
» The Main Window

» Loading and Saving

» Mouse & Keyboard

» Documentation & Tutorials

|
|
|
» Display J
|
I
l

» Acknowledgment

|~ Data Probe

L
E
B

None RAS: (125.0, -125.0, 1.0),
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Loading the Liver Scene

D Slicer 4.0.gamma-2011-11-
@ & [Modules: |4 Data " 00 IN® & s @HE 2 & | t v Persistent | @ Ao o -
@ B1
N Z
— 4
N\ /

eeeeeeeeeeeeeeeeeeeee
~ Di ify Scel
Nod
=Scel

Vi

L oad the file Scene-Liver.mrml located in:

C:\Documents and Settings\Administrator\Desktop\3DSlicerData
\LiverData
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Liver Segments Scene

The elements of the scene appear in the Viewer
\@msucer S

Welcome
s, Load DICOM Data | o Load Data |
Gaw Load Data || @ D: Data |
» About

*» The Main Window

» Loading and Saving

» Display

» Mouse & Keyboard

» Documentation & Tutorials

» Acknowledgment

~ Data Probe

whr
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o) 3D models of the liver

~ Segment |Va

-----

Segment VI Segment Il

Segment VI ~ SegmentIl

Segment V ~ Segment [Vb =

©2012-2013 Surgical Planning Laboratory, ARR Slide 75




]
|
i

.ﬁb 3D models of the liver

Segment |

Segment | ’I Segment VII

Segment | ‘
Segment IVb |y | *~ Segment VI

: -

3 S—e;gment V
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oi¢? 3D models of the liver

Middle Left portal § E i

AEDENE Vel , W= |eft hepatic
Right portal F oy 50 00 o o *
vein R W ﬁl CaudaE/ein I R

Main portal

Right hepatic gat
vein -l
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ﬁ' 3D Exploration of Liver Segments

Example:
What organ abuts the
left-most margin of
segment Il in this
patient ?
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3D Exploration of Liver Segments

3D

,,

@ # MByes: JM.QO DO ws9HE
ex [l

@BDSIicer

[» Help & Acknowledgement

®

I)

= Scene

= Liver Structures Models

= Vessels

= [VC [ |
= MainPortalVein
= LeftHepaticVein_and_Branches M
« MiddleHepaticVein_and_Bran... |
= RightHepaticVein_and_Branc...
= LeftPortalVein_and_Branches
= RightPortalVein_and_Branches
= CaudateVeins
gments
= LiverSegment_lI
= LiverSegment_|II
» LiverSegment_IVa
» LiverSegment_IVb
» LiverSegment_|
= LiverSegment_VIII
= LiverSegmentV
LiverSegmentVI
LiverSegmentVIl

EEEEEEEE

EEEETEE
EEEEEEEEE

| » Informg8lon

[~ Display
Visible:
Selected:
Clip:
Sliceg'

_ Select the module Models
. Click on the Liver Structures Models Hierarchy

= SRV an7e
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3D Exploration of Liver Segments

8006 3D Slicer 4.0.gamma-2011-11-24

& & Modules: . [@ Models " 00N @« A 9@ -E ‘E‘ 4~
1

@®
@ 3DSlicer

» Help & Acknowledgement

> @ R R | 4~

I»)

= Scene
= Liver Structures Models
= Vessels
= [VC | |
= MainPortalVein
» LeftHepaticVein_and_Branches W
» MiddleHepaticVein_and_Bran... |
= RightHepaticVein_and_Branc...
= LeftPortalVein_and_Branches
= RightPortalVein_and_Branches

Sobobodoatot
88888888

Nerpegmomsl] 1] i

= LiverSegment_IVa B 1.00
= LiverSegment_IVb W 100
= LiverSegment_| 1.00
= LiverSegment_VIII B 1.00
= LiverSegmentV | 1.00
= LiverSegmentVI W 1.00
= LiverSegmentVIl o 1.00

» Information

~ Display

Visible:

Selected:

Clip:

Slice Intersections Visible:
v Material Properties

Select the model Liver_Segment |l
Turn on/off its visibility to locate
— it in the 3D viewer. —

©2012-2013 Surgical Planning Laboiawury, Arr onuc 80

Color: [ ] \
~ Data Probe

wmr




3D Exploration of Liver Segments

®

8no 3D Slicer 4.0.gamma-2011-11-24
% & [Modules: . |@Models " QOO @« A @ HE » o 4~
1
r‘\ 3DSlicer

4
» Help & Acknowledgement

Position the mouse in
the 3D Viewer, hold
down the left mouse
button and drag to &\ /e
orient the 3D model to N — 4
a superior view. G —

L
F
B
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3D Exploration of Liver Segments

e 0o 3D Slicer 4.0.gamma-2011-11-24
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= RightPortalVein_and_Branches
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= LiverSegmentVII

EEENEN
[elelololotatal
[SIStStSISIStsts!

» Information |

~ Display |
Visible: v
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v Material Properties

Color: &
~ Data Probe

What organ abuts the left-
most margin of segment Il
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3D Exploration of Liver Segments

e 0o 3D Slicer 4.0.gar
& & |Modules: @ Models Q0 IN® e 4 9H

Question 1:

mma-2011-11-24
» ol ¢~

What organ abuts the left-

most margin of segment Il
in this patient?

Answer 1: Stomach

lice Lnter_sections V_isnble:
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3D Exploration of Liver Segments

XX 3D Slicer 4.0.gamma-2011-11-24
@ & |Modules: . [@ Models " QO IO e 42 @HE » PRI Y » fa fa, -
1
eO®

®

Question 2:

Which segment would
most likely be affected by
an aggressive tumor
invading locally from the

right adrenal gland ?

w i
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3D Exploratlon of leer Segments

8 no 0.gamma-.
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Question 2:

Which segment would
most likely be affected by
an aggressive tumor
invading locally from the
right adrenal gland ? —
Answer 2: Segment VI
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‘ﬁ' 3D Exploration of Liver Segments

~ Question 3:

" B \Which vessel separates
Segment Vb and
Segment V?

e
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Middle Hepatic Vein

000 3D Slicer 4.0.gamma-2011-11-24 u
& Modules: . [@Models =0 QI ® @« 4 @& F\t' | Mlddle
o= [l
@ 3DSlicer
v

| » Help & Acknowledgement |8
= Scene
= Liver Structures Models

= Vessels
o IVC m 1.00
< MainPortalVein 1.00
< LeftHepaticVein_and_Branches M 1.00
= MiddleHepaticVein_and_Bran... [§ 1.00
< RightHepaticVein_and_Branc... 1.00
< LeftPortalVein_and_Branches 1.00
< RightPortalVein_and_Branches 1.00
< CaudateVeins 1.00

= Segments
< LiverSegment_II

-
Q9
S

< LiverSegment_llI

< LiverSegment_IVa

LiverSegment_IVb

LiverSegment_|

LiverSeg mentVVI 1l
I

-
LiverSegmentVI|
< LiverSegmentVII

|» Information |

| ~ Display

\liniklA- >

Question 3:
Which vessel separates Segment IVb and Segment V?
Answer 3: The middle hepatic vein
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Closing the Liver Scene
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Part 4:

Interactive 3D Visualization
of the segments of the lungs
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Segments of the lung

Segmentation and 3D surface
reconstruction of the lung and
pulmonary vessels

Acknowledgment:
Segmentation of the lung surface and vasculature:

Raul San Jose Estepar, Ph.D., George Washko,
M.D., Ed Silverman, M.D. and James Ross, MSc.

Brigham and Women’s Hospital

(K25 HL104085) and COPDGene (01 HL089897
and UO1 HLO89856)
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N Segments of the lung

3D parcellation of arteries and veins from

original model of pulmonary vessels
(Kitt Shaffer, M.D., Ph.D. - Sonia Pujol, Ph.D.)

- Right Upper Lobe (RUL)
- RUL Pulmonary Vein
- RUL Anterior Segment
- RUL Apical Segment
- RUL Posterior Segment
- Right Middle Lobe (RML)
- RML Pulmonary Vein 1 & 2
- RML Lateral Segment
-  RML Medial Segment
- nght Lower Lobe (RLL)
RLL Pulmonary Vein 1,2,3
- RLL Anterior Basal Segment
- RLL Medial Basal Segment
- RLL Lateral Basal Segment
©2012-2013 Surgical Planning Laboratory, ARR -  RLL Posterior Basal Segment




Loading the Chest Data Scene

800
File Edit View Help
ga & % Modules: . [Welcome to Slicer (=009 e« ~ t v @ M R

g 30Slicer

Welcome

=& Load DICOM Data || e Load Data ]
[ #Customize Slicer || @ Download Sample Data|

3D Slicer,4,2.021¢152012510,28

» About
» The Main Window

» Loading and Saving

» Mouse & Keyboard

» Documentation & Tutorials
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» Display J
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» Acknowledgment

|~ Data Probe
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None RAS: (125.0, -125.0, 1.0),
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Loading the Lung Scene
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Load the file LungSegment_Scene.mrml |located in:

C:\Documents and Settings\Administrator\Desktop\3DSlicer
\LungData
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Loading the Lung Scene
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Welcome
Load DICOM Data [eucy Load Data

@ Load Volume Data || @ Download Sample Data

» About

» The Main Window

» Loading and Saving

» Display

» Mouse & Kevboard

Position the mouse cursor in the
top left cornet of the 3D viewer,
and select the top left icon to
center the 3D view on the scene

[ss Ryl
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Loading the Lung Scene
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ung Segments
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Lung Segments — Question 1
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Lung Segments — Question 2
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Question 2:Which
segment’s vascular
supply is shown at the
arrow?
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Lung Segments — Question 2
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Lung Segments — Question 3
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Lung Segments — Question 3
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ung Segments — Question 4
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Lung Segments — Question 4
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Lung Segments — Question 4
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3D Visualization of DICOM images

 Interactive user-interface to
load and manipulate
greyscale volumes,
labelmaps and 3D models.

» User-defined 3D view of the
anatomy

« 3D Open-source platform for
Linux, Mac and Windows
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www.slicer.org
WWW.Na-mic.org

Questions and comments: spujol@bwh.harvard.edu
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